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ABSTRAK 

Penelitian ini bertujuan untuk mengembangkan modul praktikum bandul matematis 

berbasis spreadsheet pada microsoft excell 2007 dan kualitas modul yang 

dikembangkan berupa modul praktikum bandul matematis berbasis spreadsheet pada 

microsoft excell 2007 agar pengguna media maupunpraktisi dapat membuat media 

dengan memanfaatkan modul praktikum bandul matematis berbasis spreadsheet pada 

Microsoft excell 2007. Dengan memanfaatkan teknologi komputer yang dikemas dalam 

program spreadsheet pada microsoft excell 2007 menyajikan fasilitas secara sederhana 

dan mudah. Disamping itu penelitian ini mengunakan metode penelitian model Borg & 

Galls melalui 3 tahapan, yaitu (1) studi pendahuluan, (2) pembuatan dan pengembangan 

produk (media praktikum dan modul praktikum) dan (3) pengujian dan implementasi 

Produk(evaluasi). Dari hasil uji coba yang dilakukan dari beberapa ahli dan praktisi 

maupun pengguna media dalam kelompok besar dan kelompok kecil yaitu modul  yang 

dibuat dan kualitasnya dikembangkan sudah layak untuk digunakan  tetapi ada sedikit 

permasalahan sehingga perlu adanya perbaikan lebih lanjut.  

 

Kata kunci: Spreadsheet, Microsoft Excell, Bandul Matematis. 
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BAB 1 

PENDAHULUAN 

1.1. Latar Belakang Masalah 

Pembelajaran merupakan interaksi peserta didik dengan pendidik dan sumber 

belajar pada suatu belajar (pesrta didik) dan kreatifitas pengajar (pengajar). Salah 

satu yang dilakukan guru adalah dengan menerapkan pembelajaran praktikum abad 

ke – 21 ini akan lebih termotivasi belajarnya dengan memanfaatkan model praktikum 

berbasis Teknologi Informasi dan Komunikasi (TIK), salah satunya dengan 

memanfaatkan model praktikum virtual lab. 

Virtual lab atau lab maya adalah model praktikum berbasis TIK yang 

dikembangkan dengan tujuan untuk memberikan ruang bagi pengguna melakukan 

eksplorasi dan eksperimen secara virtual. Laboratorium sering disingkat lab 

merupakan tempat siswa biasanya melakukan eksperimen terhadap suatu objek yang 

butuh dipastikan kebenarannya.Selain itu, maya karena kontenya direkayasa 

menyerupai kondisi sesungguhnya. Dengan melakukan eksplorasi atau percobaan 

atau eksperimen menyerupai kondisi rill nya, diharapkan peserta didik akan 

mendapatkan presisi yang ideal sehingga meningkatkan kualitasnya, terutama tingkat 

keaktifan peserta didik dalam mencari fenomena – fenomena alam yang terjadi. 

Selain itu virtual lab disampaikan dengan bantuan komputer. Komputer dan 

teknologi akan memiliki dampak signitifikan pada pengajaran. Teknologi dapat dan 

memang memiliki arti penting. Bukti – bukti mulai menunjukkan adanya hubungan 

antara penggunaan teknologi dan prestasi siswa (Lathan 1999, diacu dalam Arends 

2008). Komputer sebagai produk teknologi dapat digunakan sebagai media 
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pembelajaran yang efektif untuk mengajarkan konsep – konsep abstrak. Komputer 

juga efektif sebagai alat untuk simulasi praktikum (Suyatna,2009).    

Berdasarkan latar belakang dan permasalahan tersebut penelitian bertujuan 

untuk mengembangkan laboratorium virtual pada mata pelajaran fisika dengan pokok 

bahasan mengenai bandul matematis. Modul praktikum fisika dikembangkan dengan 

menggunakan software microsoft excell berbasis spreadsheet. Oleh karena itu 

penulis mengangkat judul “ Pengembangan Media dan Modul Praktikum Bandul 

Sistematis Berbasis SpreadSheet pada Microsoft Excell 2007”. 

1.2. Batasan Masalah 

Penelitian ini dilakukan pada materi bandul matematis. 

1.3. Rumusan Masalah 

1. Bagaimana mengembangkan modul praktikum bandul matematis berbasis 

Spreadsheet pada Microsoft Excell 2007 ? 

2. Bagaimana kualitas modul praktikum bandul matematis berbasis Spreadsheet pada 

Microsoft Excell 2007 ? 

1.4. Tujuan Pengembangan 

1. Mengembangkan modul praktikum bandul matematis berbasis spreadsheet pada 

microsoft excel 2007. 

2. Kualitas produk yang dikembangkan berupa modul praktikum bandul matematis 

berbasis Spreadsheet pada Microsoft Excell 2007 ? 

1.5. Spesifikasi Produk Yang Diharapkan 

Spesifikasi yang diharapkan dari pengembangan praktikum bandul matematis 

berbasis spreadsheet pada micrisoft excell 2007 adalah sebagai berikut : 

2 



 

 

1. Produk yang dikembangkan adalah pengembangan modul praktikum bandul 

matematis berbasis spreadsheet pada microsoft excell 2007 

2. Cover modul pembuatan media praktikum didesain dengan warna yang menarik. 

3. Isi dari modul didesain lengkap dengan teori dan gambar – gambar untuk 

memperjelas dalam membuat medaipraktikum. 

4. Modul yang dibuat dapat memberi kemudahan kepada praktisi untuk membuat 

media praktikum. 

5. Perbedaan penelitian ini mengulas materi tentang bandul matematis dengan 

bantuan software microsoft excell 2007 berbasis spreadsheet sedangkan penelitian 

sebelumnya mengulas materi tentang gerak parabola bantuan software microsoft 

excell 2007 berbasis spreadsheet. 

1.6. Pentingnya Pengembangan 

Melalui penelitian yang dikukan oleh peneliti, peneliti berharap dapat 

memberikan manfaat sebagai berikut : 

1.6.1 Manfaat Praktis 

1. Manfaat untuk Pengembangan Ilmu 

Manfaat  pengembangan media dan modul praktikum bandul matematis 

berbasis spreadsheet pada microsoft excell 2007 mempunyai manfaat terhadap 

praktisi maupun peneliti lain sehingga dapat memanfaatkan teknologi untuk 

mengembangkan dan membuat rancangan media dan modul praktikum pada mata 

pelajaran fisika seperti pada materi pegas, gerak melingkar dll. 

2. Manfaat bagi praktisi 
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Menjadi alternative bagi guru dalam menyajikan materi pembelajaran yang 

dapat diterapkan didalam kelas. 

3. Manfaat bagi pengguna media 

Memudahkan siswa melakukan praktikum karena semua alat dan bahan 

praktikum telah disediakan secara virtual. 

1.6.2. Manfaat Teoritis 

1. Menambah khasanah keilmuan bagi pembaca maupun praktisi untuk 

memanfaatkan Teknologi Informasi dan Komputer agar pembaca maupun praktisi 

dapat membuat media praktikum dengan memanfaatkan modul untuk membuat 

media praktikum. 

2. Mendapatkan media pembelajaran yaitu pengembangan media dan modul 

praktikum bandul matematis berbasis spreadsheet pada microsoft excell 2007 

sebagai bahan pertimbangan untuk penelitian berikutnya yang sejenis 

1.7. Asumsi dan Keterbatasan Pengembangan 

Asumsi yang digunakan peneliti pada pengembangan praktikum berbasis 

spreadsheet pada microsoft excell 2007 adalah : 

1. Validator modul atas hasil pengembangan memiliki pengembang dan kompeten 

dalam bidang pembelajaran 

2. Validasi yang dilakukan mencerminkan keadaan sebenar -  benarnya dan tanpa 

rekayasa, paksaan atau pengaruh dari siapapun. 

3. Butir – butir penilaian dalam angket validasi menggambarkan penilaian yang 

menyeluruh. 

4. Kegiatan validasi dilakukan pada seluruh spesifikasi yang diharapkan. 
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5. Pengembangan modul praktikum bandul matematis berbasis spreadsheet pada 

microsoft excell 2007 membatasi pada materi Bandul Matematis. 

6. Produk yang dikembangkan peneliti adalah cara untuk membuat media praktikum 

dengan bantuan modul untuk membuat media praktikum berbasis spreadsheet 

pada microsoft excell 2007. 

1.8. Definisi Istilah 

Istilah – istilah yang perlu didefinikan secara operasional dalam pengembangan 

praktikum bandul matematis berbasis spreadsheet ada microsoft excell 2007 adalah : 

1. Modul praktikum adalah salah satu bentuk bahan ajar yang dikemas secara 

sistematis dan menarik sehingga mudah untuk dipelajari secara mandiri. 

2. Spreadsheet merupakan softwere yang digunakan untuk menangani (mengolah) 

data dalam bentuk kolom dan baris. Data dapat berupa angka, rumus – rumus kita 

letakkan dalam kotak (sel) yeng merupakan perpotongan antara baris dan kolom. 

3. Microsoft excell adalah sebuah program aplikasi lembar kerja spreadsheet yang 

dibuat dan didistribusikan oleh Microsoft Corporation yang dapat dijalankan pada 

Microsoft Windows dan Mac OS 

4. Bandul matematis adalah salah satu benda yang bergerak mengikuti gerak 

harmonik sederhana yaitu gerak bolak – balik melalui suatu titik keseimbangan 

tertentu denganbanyaknya getaran benda dalam setiap sekon selalu konstan.  
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BAB II 

TINJAUAN PUSTAKA 

2.1. Gerak  Bandul 

Gerak bandul merupakan gerak harmonik sederhana hanya jika amplitudo 

geraknya kecil. gambar 2.1 memeperlihatkan bandul sederhana yang terdiri dari tali 

dengan panjang L dan beban bermassa m. Gaya yang bekerja pada beban adalah 

beratnya mg dan tegangan T pada tali. Bila tali membuat sudut Ф terhadap vertikal, 

berat memiliki komponen – komponen mg cos Ф sepanjang tali dan mg  sin Ф tegak 

lurus tali dalam arah berkurannya Ф. Misalkan s sebagai panjang busur diukur dari 

dasar lingkaran. Panjang busur dihubungkan ke sudut Ф oleh : 

   Ф 

Komponen tangensial tangensial percepatan benda adalah d²s/dt². Komponen 

tangensial hukum kedua newton adalah : 

∑            Ф  (   )   
   

   
 

Atau  

   

   
      Ф          

 

 
 

 

Jika s jauh lebih kecil dari pada s/L, sudut Ф = s/L adalah kecil, dan kita dapat 

mendekati sin Ф dengan sudut Ф. Dengan menggunakan sin (s/L) ≈ s/L dalam 

persamaan 2.2, kita akan memperoleh : 

(Tipler. 1998) 

 

2.1 

2,2 

2.3 
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  Ф  

 

 

  Ф 

  

 

  

   

   
  

 

 
  

Kita dapat melihat bahwa untuk sudut cukup kecil sehingga sin Ф ≈ Ф berlaku, 

percepatan berbanding lurus dengan simpangannya. Gerak bandul dengan demikian 

mendekati gerak harmonik sederhana untuk simpangan kecil. Persamaan 2.4 dapat 

ditulis sebagai berikut  

   

   
      

Dengan  

  
 

 
 

Penyelesaian persamaan 2.5 adalah s = sₒ cos (ωt + δ), dengan sₒ adalah simpangan 

maksimum diukur sepanjang busur lingkaran. Priode gerak harmonik tersebut adalah  

  
  

 
   

√ 

√ 
 

 

T 

L 

mg 

mg cos Ф s 

mg sin Ф 

2.4 

2.5 

2.6 

2.7 

Gambar 2.1. gerak bandul 
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Menurut persamaan 12-32 makin panjang tali, makin besar periode, yang konsisten 

dengan pengamatan eksperimen. Perhatikan bahwa periode tidak bergantung massa. 

Hal ini berlaku karena gaya pemulih berbanding lurus dengan massa. Karena itu, 

percepatan a = F/m karena itu tak bergantung pada massa. Perhatikan bahwa 

frekuensi dan periode tak bergantung pada amplitudo osilasi, segi umum gerak 

harmonik sederhana. 

 

Ya Seringkali gerak bandul sederhana lebih mudah dinyatakan dalam bentuk 

simpangan sudut Ф. Dengan menggunaka s = L/Ф dalam persamaan 2.3, kita akan 

memperoleh  

  ( Ф)

   
        Ф 

 

Atau 

  ( Ф)

   
  

 

 
   Ф 

Yang untuk Ф kecil menjadi  

  ( Ф)

   
  

 

 
    Ф 

 

Penyelesaian persamaan 2.10 adalah 

Ф  Фₒ    (    ) 

Dengan Фₒ = sₒ /L sebagai simpangan sudut maksimum. Kriteria gerak harmonik 

sederhana yang dinyatakan dlam besaran – besaran sudut ini adalah bahwa percepatan 

2.8 

2.9 

2.10 

2.11 

(Tipler.1998) 
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sudut harus berbanding lurus dengan simpangan sudut dan berlawanan arah seperti 

dalam persamaan 2.10. 

(Tipler.1998) 

2.2. Spreadsheet Microsoft excel 

Microsoft Excel adalah suatu aplikasi berbasis spreadsheet yang dikembangkan 

oleh Microsoft Corporation untuk Windows, Mac OS X, Android and iOS. Pada 

umumnya, Microsoft Excel tidak lebih dari sebuah kalkulator atau sebuah worksheet 

yang dapat melakukan perhitungan, hal-hal yang berhubungan dengan grafik, 

ataupun pemrograman makro. Selain itu, Microsoft Excell juga kebanyakan hanya 

diketahui sebagai pengolah kata sederhana dengan tabel yang telah built-in. Tidak 

banyak orang yang mengetahui mengenai fitur pemrograman makro ini yang 

memungkinkan user memanipulasi dan mengoptimalkan program dibandingkan fitur 

standar spreadsheet. User dapat membuat program sendiri secara langsung dengan 

menggunakan Visual Basic Editor (VBE) yang meliputi fitur menulis, debugging, 

dan membuat berbagai fungsi (dalam VBA akan disebut module). User dapat 

menerapkan metode numerik dan mengoptimalkan berbagai kerjaan seperti 

organisasi data, dan memandu perhitungan di VBA. 

Untuk menggunakan fitur VBA Excel, diperlukan menu developer. Adapun 

cara untuk menampilkan menu developer adalah: 

1. Microsoft Excel 2007 

Dari menu utama, masuk ke Excel options > pada tab Populat, centang Show 

Developer tab in the Ribbon 

 

(Departemen Fisika ITB. 2010) 
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Gambar 2.2. Menampilkan Ribbon Developer pada Ms. Office 2007 

2. Microsoft Excel 2010 ke atas 

Pilih menu File > Options > Customize Ribbon > pilih Developer. 

 

 

 

 

 

Gambar 2.3. Menampilkan Ribbon Developer pada Ms. Office 

2010 ke atas 

 

 MACRO READER 

Fitur ini berfungsi untuk merekam setiap aktivitas yang dilakukan 

pada worksheet. Macros akan menyimpan keadaan worksheet tepat 

sebelum Stop Recording dipilih. 

 

 

 

Gambar 2.4 Tampilan Menu Macros 

Record Macro dapat diaktifkan ketika proses membuat tabel atau mengisi 

data apapun, kemudian ingin mengetahui bagaimana code VBA (Visual Basic 

(Departemen Fisika ITB. 2010) 

10 



 

 

for Application) yang dibentuk. Agar lebih memahami, coba langkah-langkah 

berikut: 

1. Aktifkan Record Macro pada ribbon developer saat worksheet masih 

kosong. Beri keterangan pada Macro name, contoh: Macro1 (tidak boleh 

ada spasi dan karakter khusus). Shortcut key dan Description bersifat 

optional. 

 

 

 

 

 

 

 

Gambar 2.5. Tampilan Record Makro 

 

2. Tuliskan nama Anda pada sel yang aktif. Pada gambar di atas, misalkan sel 

A1. 

3. Pindahkan sel aktif ke sel dibawahnya (pada kasus diatas, dimisalkan A2). 

Ketikan formula berikut: 

4. Pilih formula sel tersebut dan tekan Ctrl+C untuk copy sel ke clipboard. 

5. Paste nilainya sebagai values (V) untuk mengonversi formula ke nilainya. 

6. Pilih sel aktif dan sel di atasnya yang tadi telah ditulis nama. Dalam kasus 

ini sel A1 dan A2. 

7. Ubah format menjadi Bold dan ukuran font 18 pt. 

8. Pilih ribbon Developer, klik Stop Recording. 

9. Untuk melihat code macro yang telah dibuat, klik Visual Basic di ribbon 

Developer untuk membuka Visual basic Editor. 

(Departemen Fisika ITB. 2010) 
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 MENULIS “HELLO WORLD!” DALAM KOTAK PESAN 

Pada latihan ini, dengan mengeklik suatu tombol, akan muncul kotak 

pesan yang bertuliskan “Hello World!”. Adapun langkahnya adalah : 

1. Pada ribbon developer, pilih Insert, di bagian Active X Control, dan 

masukkan item Button ke dalam sheet excell. 

 

 

 

 

 

Gambar 2.6. Insert tombol 

 

 

2. Letakkan pada sheet excel dengan click and drag untuk mengatur 

ukuran tombol. 

 

 

 

 

 

Gambar 2.7. Command Button 

Untuk mengubah tulisan CommandButton1, harus dipastikan menu 

Design Mode di ribbon developer aktif. Kemudian klik kanan > 

CommandButton Object > Edit. 

3. Double-click button tersebut, sampai muncul jendela program, ketikan 

program berikut untuk menampilkan kotak pesan. 

 (Departemen Fisika ITB. 2010) 
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Gambar 2. 8. Tampilan Visual Basic Editor atau Excel VBA 

Integrated Development Environment (IDE) 

 

4. Jalankan program dengan menekan tombol play (lihat bulat 

merah di gambar di atas) 

5. Hasil akhir yang diharapkan minimal sebagai berikut : 
 

 

 

     

 

Gambar 2.9. Hello World pada kotak pesan 

 

 INSERT NILAI MELALUI KOTAK PESAN YANG DIBUAT 

DENGAN FUNGSI 

Selain untuk menampilkan pesan, Kotak Pesan juga dapat digunakan 

untuk memasukkan suatu nilai yang nantinya dapat diolah lebih lanjut 

untuk ditampilkan pada sheet excell. Pada latihan ini, diperkenalkan suatu 

fungsi yang nantinya akan dipanggil ketika mengeklik tombol. Adapun 

langkahnya sebagai berikut. 

(Departemen Fisika ITB. 2010) 
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1. Pada ribbon Developer, klik Visual Basic untuk menampilkan Visual 

Basic Editor atau Excel VBA Integrated Development Environment 

(IDE) 

2. Pilih Insert > Module 

3. Ketikan program berikut. 

 

 

 

 

 

Gambar 2.10. Program fungsi module 

4. Buat tombol baru kemudian ubah tulisan “CommandButton1” menjadi 

“Masukkan Nilai”. 

5. Double-click button tersebut, sampai muncul jendela program, ketikan 

program berikutuntuk menampilkan kotak pesan. 

  

(Departemen Fisika ITB. 2010) 
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Gambar 2.11. Memasukkan fungsi module yang telah dibuat pada 

command button 

 

6.  Sehingga tampilan akan seperti berikut: 

 

 

 

 

 

Gambar 2.12. Latihan Mandiri dengan Input Nilai melalui Box 

(Departemen Fisika ITB. 2010) 
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BAB III 

METODE PENGEMBANGAN 

3.1.Model Pengembangan 

Dalam bidang pendidikan tujuan utama penelitian dan pengembangan bukan 

untuk merumuskan atau menguji teori, tetapi untuk mengembangkan produk-produk 

yang efektif untuk digunakan di sekolah. Produk yang dihasilkan dalam penelitian 

pengembangan ini adalah modul dan alat media praktikum. Penelitian 

pengembangan merupakan kegiatan mengembangkan suatu produk baru atau 

menyempurnakan produk yang telah ada (Emzir, 2014). Penelitian pengembangan 

(Reseach & Development) adalah metode penelitian yang digunakan untuk 

menghasilkan produk (Sugiyono, 2013). Borg & Gall (2003) menyatakan bahwa 

model penelitian dan pengembangan dalam bidang pendidikan dan pembelajaran 

sebagai “a process used to develop and validate educational products”. Model 

pengembangan yang digunakan dalam penelitian ini adalah Borg & Gall yaitu 

menggariskan langkah-langkah untuk menghasilkan produk berupa alat peraga yaitu:  

 

Tabel 3.1 Langkah-langkah penelitian dan penelitian Borg & Gall 

Langkah Utama Borg & Gall 10 langkah Brog & Gall 

Penelitian dan pengumpulan informasi 

( Research and Information Collecting) 

1. Penelitian dan pengumpulan informasi 

Perancangan (Planing) 2. Perancangan 

Pengembangan bentuk awal produk 

 (Develop Pleniminary Form Product) 

3. Pengembangan bentuk awal produk 

Uji Lapangan dan Revisi Produk 

 (FIELD Testing and Product Revision) 

1. Uji lapangan awal 

2. Revisi produk 

3. Uji lapangan utama 

4. Revisi produk operasional 

8. Uji lapangan operasional 

Revisi Produk Akhir  

( Final Product Revision ) 

9. Revisi Produk Akhir 

Diseminasi dan Implementasi 

 (Dissemination and Implementation 

10. Diseminasi dan Implementasi 

(Emzir, 2014) 
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3.2. Prosedur Pengembangan 

Prosedur pengembangan yang dilakukan pada penelitian pengembangan ini 

mengacu kepada prosedur Borg & Galls melalui 3 tahapan, yaitu (1) studi 

pendahuluan, (2) pembuatan dan pengembangan produk (media praktikum dan 

modul praktikum) dan (3) pengujian dan implementasi Produk (evaluasi).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

Gambar 3.1. Prosedur Pengembangan Produk 

 

 

 

Studi Pustaka Survey Lapangan 

Studi Pendahuluan 

 
Pembuatan & Pengembangan Produk 

Merancang Mengembangkan Mengevaluasi 

 

Produk Awal 

Pengujian & Implementasi 

Validasi Ahli & Ahli Media Analisis & Revisi 

Peer Reviewer Analisis & Revisi 

Analisis dan Revisi 

Uji Coba Produk 

Uji Coba Lapangan Analisis & Revisi 

 
Modul Praktikum Bandul Matematis 

Berbasis Spreadsheet Pada Microsoft Excell 2007 
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3.3. Uji Coba Produk 

3.3.1. Tehnik Pengumpulan Data 

Instrumen yang digunakan untuk mengumpulkan data pada penelitian ini 

berupa angket validasi modul dan media praktikum. Instrumen tersebut digunakan 

untuk menghasilkan produk yang berkualitas 

3.3.2. Kisi Kisi Instrumen 

Penilaian instrument dilakukan berdasarkan indikator masing-masing 

kompenen penilaian seperti pada Tabel 3.1 media praktikum dan angket modul 

praktikum berikut ini: 

Tabel 3.2  Kisi-kisi angket validasi media praktikum dan modul Praktikum 

No Aspek Indikator Responden 

Ahli 

Media  

Ahli 

Materi 

Praktisi Pengguna 

Media 

1 Keterkaitan 

dengan 

bahan ajar 

Konsep yang di 

ajarkan 

 √ √  

  Tingkat keperluan 

alat untuk 

pembelajaran 

 √ √  

  Kejelasan obyek dan 

fonemena 

 √ √  

2 Nilai 

pendidikan 

Kesesuain dengan 

perkembangan 

intelektual peserta 

didik 

 √ √  

 

 

 Kompentensi yang di 

tingkatkan pada 

peserta didik 

 √ √  

3 Keakuratan 

media  

Ketepatan dalam 

membaca hasil nilai 

pada media 

praktikum 

√  √ √ 

4 Efesiensi 

media 

Kemudahan 

dirangkaikan 

√  √ √ 

  Kemudahan 

digunakan/dijalankan 

√  √ √ 

5 Estetika Warna  √  √ √ 
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  Bentuk  √  √ √ 

6 Kelayakan 

Tampilan 

Ukuran modul √  √  

  Desain kulit modul √  √  

  Desain isi modul √  √  

7 Kelayakan 

Isi 

Kesesuaian materi 

dengan SK dan KD 

 √ √  

  Keakuratann materi  √ √  

  Kesesuaian modul 

dengan media 

praktikum 

 √ √  

8 Kelayakan 

Bahasa 

Penggunaan bahasa 

sesuai EYD 

√ √ √  

  Bahasa yang 

digunakan 

komunikatif 

√ √ √  

  

 

Kesederhanaan 

struktur kalimat 

√ √ √  

9 Evaluasi Bahasa evaluasi jelas 

dan sesuai tujuan 

 √ √ √ 

10 Aspek 

Karakter 

Praktikum 

membentuk karakter 

teliti , kreatif dan 

tanggung jawab 

 √ √ √ 

(Arsyad, 2015) 

Hasil validasi media praktikum dan modul oleh ahli materi dan media sebagai 

untuk tahap awal revisi produk, yang kemudian diujikan kepada praktisi dan 

pengguna media berupa uji kelompok kecil dan uji kelompok besar. Angket 

berisikan aktifitas pengguna media berkaitan dengan model yang digunakan pada 

modul dan berkaitan dengan aktifitas pengguna media yang akan dikembangkan 

digunakan pada awal dan akhir proses pembelajaran (Nanang, 2016). 

3.3.2 Desain Uji Coba 

Produk berupa modul perlu dilakukan pengujian untuk mengetahui kualitas dan 

kelayakannya. Uji produk adalah bagian dari rangkaian tahap validasi dan evaluasi. 

Produk akan dikonsultasikan kepada dosen pembimbing, pakar / ahli, praktisi, dan 
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pengguna media sebagai calon pemakai modul. Berikut adalah langkah – langkah 

dalam tahapan validasi dan evaluasi : 

1. Pravalidasi 

Pada tahap ini, peneliti melakukan konsultasi dengan dosen pembimbing 

tentang produk modul yang telah disusun. Tujuan dari tahap ini adalah untuk 

mendapatkan masukan, kritik, dan saran dari dosen pembimbing tentang kualitas 

modul sebelum ahli / pakar melakukan validasi. Diharapkan masukkan dari dosen 

pembimbing akan membuat produk modul semakin berkualitas. 

2. Validasi pakar 

Ahli / pakar melakukan validasi terhadap modul agar dapat diketahui 

kekurangan yang masih ada. Hasil dari validasi ahli / pakar akan menjadi bahan 

untuk membuat revisi produk. Ahli / pakar menilai kelayakan modul ditinjau dari 

dari empat komponen kelayakan yaitu aspek materi, bahasa dan gambar, penyajian 

dan tampilan. 

3. Uji keterbacaan pengguna produk 

Uji keterbacaan pengguna produk dilakukan pada mahasiswa pendidikan fisika 

universitas muhammadiyah mataram . tujuan dari keterbacaan pengguna produk 

adalah untuk mengetahui kelayakan modul yang telah dikembangkan berdasarkan 

penilaian pengguna produk. Modul yang sudah divalidsai oleh validator perlu 

disempurnakan lagi agar lebih relevan dan maksimal sesuai kebutuhan pengguna 

produk.  
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3.3.3 Subjek Uji Coba 

Subjek uji coba terdiri atas ahli materi, ahli media, praktisi dan sasaran 

pemakai produk. Dimana subjek uji coba untuk ahli materi, ahli media dan praktisi 

berfungsi sebagai validator yaitu dengan mengisi instrumen berupa angket dan 

memberi kritik atau saran terhadap produk penggembangan. Validasi dilakukan agar 

mengetahui kelayakan produk yang dikembangkan. 

3.4. Instrument Pengumpulan Data 

Instrumen penelitian digunakan untuk mengukur nilai variabel yang akan 

diteliti. Dengan demikian jumlah instrumen yang akan digunakan untuk penelitian 

akan tergantung pada jumlah variabel yang diteliti (Sugiyono, 2014 : 92). Secara 

spesifikasi fenomena yang terjadi disebut variabel penelitian. Instrumen yang 

digunakan dalam penelitian ini berupa lembar saran dan komentar serta kuisioner. 

Kuisioner adalah teknik pengumpulan data yang dilakukan dengan cara memberi 

seperangkat pertanyaan atau pernyataan tertulis kepada responden untuk 

menjawabnya. Kuisioner merupakan teknik pengmpulan data yang efisien bila 

peneliti tahu dengan pasti variabel yang akan diukur dan tahu apa yang bisa 

diharapkan dari responden (Sugiyono, 2014 : 142). 

Angket validasi media pembelajaran memiliki gradulasi pernyataan sangat 

positif sampai sangat negatif untuk mengukur indikator program yang berkaitan 

dengan kriteria pendidikan, tampilan dan kualitas teknis (Arsyad, 2015 : 219) 
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Skala pengukuran yang digunakan untuk mengukur validasi produk dan 

pemahaman konsep siswa adalah skala likert yang memiliki gradulasi penilaian 

dari sangat positif sampai sangat negatif. Teknik skorsing dalam skala likert  

adalah sebagai berikut (Sugiyono, 2014 : 94) : 

Tabel 3.3. Skala Likert 

No  Kriteria Skor 

1 Sangat Setuju (Sangat Positif) 5 

2 Setuju ( Positif) 4 

3 Kurang Setuju (Negatif) 3 

4 Tidak Setuju (Sangat Negatif) 2 

5 Sangat Tidak Setuju ( Sangat Negatif) 1 

 

Skala likert digunakan untuk mengukur sikap, pendapat, dan perseprsi 

seseorang atau kelompok orang tentang fenomena social. Dengan skala likert, 

variabel yang akan diukur dijabarkan menjadi indikator variabel. Kemudian 

indikator tersebut dijadikan sebagai titik tolak untuk menyusun itrm – item 

instrument yang dapat berupa pertanyaan atau pernyataan. Jawaban setiap item 

instrument yang menggunakan skala likert mempunyai gradasi dari sangat positif 

sampai negatif , yang dapat berupa kata – kata antara lain Sangat Setuju skornya 

5, Setuju skornya 4, Kurang Setuju skornya 3, Tidak Setuju skornya 2, Sangat 

Tidak Setuju skornya 1. Sehingga sesesorang sedang mengisi angket validasi. 

(Sugiyono, 2014) 
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3.5. Teknik Analisis Data 

Analisis data angket validasi produk pada penelitian ini dilakukan untuk 

mengetahui kelayakan produk yang dikembangkan sebelum digunakan. Dimana 

data yang diperoleh melalui penelitian ahli media kemudian akan dijumlahkan dan 

total skor yang diperoleh dikonversikan menjadi data kualitatif dengan skala lima 

(Azwar, 2015 : 163) 

Tabel 3.4. Konversi Data Kuantitatif Ke Kualitatif Dengan Skala Lima 

 

 

 

 

Keterangan  :  

 X  : Total skor responden 

 M  : Mean ideal ½ ( skor maksimal ideal + skor minimal ideal) 

 S  : Simpangan baku ideal, 1/6 (skor maksimal + skor minimal 

ideal) 

 

 

 

 

 

 

 

 

Interval Kriteria Skor 

(M+1,50s) < X Sangat Baik A 

(M+0,50s) < X ≤ (M+1,50s) Baik  B 

(M+0,50s) < X ≤ (M+0,50s) Cukup Baik  C 

(M+1,50s) < X ≤ (M+0,50s) Kurang Baik D 

(X≤ M-1,50s) Tidak Baik E 
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